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Folder (menu option)

The Folder menu gives you seven menu choices on a drop-down menu. They let you create new folders
or modify, delete, or rearrange the existing folders. You can get to a related menu by clicking the right
mouse button on a folder title.

Click on the menu choices below to learn more about each one.

Folder
New
Edit

Delete

Prev Folder Alt+PgUp
MNext Folder Alt+PgDn

Move Up
Move Down




Menu bar

The Viewer menu bar contains seven menu options. Click on the menu choices below to learn more
about each one.

File Topic Folder Page Item Launch Help
When you're in the mail topic, an additional menu choice called Malil is also available.




Viewing area

The area that takes up most of the right side of the Viewer is called the viewing area. It's divided by a
movable bar into an upper and lower portion. You can adjust the relative size of the two portions of the
viewing area by dragging the bar.

» The lower portion displays the information you've asked to see, one page at a time. You tell
Rosebud what to display here by setting up folders.  You can change how the display looks (colors,
fonts, and so on) at the appropriate Display Selection dialog boxes (Mail, News, Financial, and
Weather).

» The upper portion of the viewing area lists the titles of all the pages in the folder. To see any page,
click on its title in the upper portion of the viewing area.



Folders

In the Viewer, folders are represented by labels next to file folder icons at the left edge of the screen.
You create a folder for each collection of information you want to view. When you then click on the
folder, the information you asked for, formatted the way you asked for it, appears in the viewing area.

Some things to keep in mind as you set up folders

» The information you can view depends on what information has been retrieved. You specify what
to retrieve in the separate component of Rosebud called the Assignment Desk.

» Retrieved information is stored in databases, and like any database information, can be arranged
in any number of ways for viewing.

» There is not a one-to-one relationship between reporters (in the Assignment Desk) and folders (in
the Viewer).

» Until you create a folder to view information, you can't see that information, even if it's been
successfully retrieved.

This is key to working with Rosebud. The existing folders that Rosebud came with are there
only because we specifically created them before we shipped the product, as sample folders
that would show you the information our sample reporters retrieved. This is a critical
concept: You create folders to look at information your reporters retrieve. We specifically
created folders to look at information our reporters retrieved; you must specifically create
folders to look at information your reporters retrieve.

Examples of different folders you might create
* In the news topic:

Suppose in the Assignment Desk you've set up a reporter that's assigned to gather news articles about
toxic waste, about health care, about movies, and to also retrieve the latest news (a general article
unrelated to a particular subject). In the Viewer, you can set up a folder labeled Health Care that only
displays the health care articles, another that displays the toxic waste articles, another for the latest news,
and another for movie reviews.

To create a folder in the news topic, click the News tool and select Folder New from the menu bar to
get the News Folder dialog box where you set up a news folder.

* In the financial topic:

You might have asked in the Assignment Desk for stock quotes for ten or twelve different stocks in a
variety of industries. Here in the Viewer you can set up a folder to view stocks in, say, just the computer
industry, another folder to view consumer stocks, or any other combination.

To create a folder in the financial topic, click the Financial tool and select Folder New to get to the
Folder Properties dialog box, where you begin setting up a financial folder.

* In the weather topic:

Suppose you've asked in the Assignment Desk for weather maps, satellite views, radar maps, and
temperature data for several different cities. You can set the Viewer up to display each city's information
in a separate folder..

To create a folder in the weather topic, click the Weather tool and select Folder New to get to the



Folder Properties dialog box, where you begin setting up a weather folder.

* In the mail topic:

Suppose you're working on several different projects, and you want to keep e-mail about each project in a
separate folder. You can set up mail folders for each project.

To create a folder in the mail topic, click the Mail tool and select Folder New to get to the Mail Folder
dialog box, where you create a mail folder.



Topic tools

The first four tools on the toolbar select the four topics (Mail, News, Financial, and Weather). You can
also select a topic by clicking Topic on the menu and selecting from the drop-down menu. The left-hand
column of the Viewer screen changes to display the folders that have been set up in each topic.




What is Rosebud?

Rosebud is a Windows-based utility that automatically logs on to CompuServe at specified times and
retrieves specified information, then lets you look at the retrieved information.

You can currently retrieve four categories ("topics") of information:

*  Mail

* News

e Financial
*  Weather

There are three principal components of Rosebud.

Rosebud Assignment Desk - the part of the program that lets you say when and what to retrieve.

Rosebud Collection Agent - the part of the program that does the retrieving, or collecting. Typically,
you never deal directly with the Collection Agent except to load it each morning.

Rosebud Viewer - the part of the program that lets you look at what's been retrieved, and create e-mail.

The retrieved information is stored in various databases on your computer; it's from these databases that
the Viewer gets the information to display. Third-party applications can also access this information.



File (menu option)

The File menu gives you eight menu choices on a drop-down menu. Click on the menu choices below to
learn more about each one.

h

Open... Ctrl+0O
Sawve Ctrl+5
Save As...

Print... Ctrl+P
Print Preview
Print Setup...

Exit




Preview

This area reflects the colors and fonts you choose for your news articles and mail messages.



Topic (menu option)

The Topic menu gives you four menu choices on a drop-down menu. Clicking on these menu choices
does the same thing as clicking on one of the first four tools on the toolbar: it changes the row of folders
to display mail folders, news folders, financial folders, or weather folders. Click on the menu choices

below to learn more about each one.

Mews
Financial
Weather




Importing a text file

As an alternative to typing the text of your mail message directly into the Rosebud Create Mail or Reply to
Mail Message dialog box, you can create a mail message in any text editor (Windows Notepad, for
example) or in any word processor that lets you save a file as text-only. Then import the text-only file into
Rosebud. The file name of the message you create needs to have a .TXT extension so that the import
function can recognize it.

How to import a text file into a mail message

1.
2.
3.

Create your message in the application of your choice and save it as text-only.
Switch to the Rosebud Viewer.

Click the Mail tool if the Mail topic is not already displayed, and go to the Create Mail or Reply to Mail
Message dialog box.

Click the Import File button on the left side of the mail dialog box. The Import File dialog box below

appears. lIt's a standard Windows file location dialog box, with the "filter" (or file type specification) in
the lower left set so that it only displays files with the .TXT extension.

Use the Directories list in the center to browse through your directory tree and locate the directory
where your .TXT file is stored. Any files in that directory that have a .TXT extension will display in the
list on the left.

If you want to see files other than .TXT files, change the setting (the filter) in the List Files of
Type area in the lower left.

In the file list, highlight the file that you want to import and click OK (or just double-click the file name).
The original mail dialog box reappears, with your imported message displayed.
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Page (menu option)

The Page menu gives you five menu choices on a drop-down menu. These menu choices let you do
things to the pages in the financial and weather topics.

Click on the menu choices below to learn more about each one.

Page
New Alt+N
Edit Alt+E
Delete Alt+D

Previous Ctrl+PgUp
Next Ctrl+PgDn

NOTE: If you're in the mail topic, these menu choices will be grayed out; that is, unavailable.
If you're in the news topic, the first three options will be unavailable.



Financial colors

The bottom half of the Financial Display Selection dialog box is made up of three tabs: Colors, Fonts, and
Settings. Note the labeled extensions of each tab at the bottom of the dialog box. Click on the
extension labeled Colors to bring the Colors tab to the top.

The Colors tab lets you change the colors of the display. In the list box on the right, double-click on the
name of the part of the viewing area you want to change (Background Color, Text Color, etc.) to bring up a
Color dialog box. (You can also bring up the Color dialog box by clicking on the viewing area name and
then clicking on Change.)

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

In the Color dialog box, click on the color you want and click OK. If you decide you have horrible color
sense and want the original colors back, click on Use Defaults. If, on the other hand, you set up a
particularly fetching color combination and you want it to be the new default, click on the Set Defaults
button; you'll get a Set Defaults dialog box asking you to confirm that you do in fact want the new color
settings to become the new defaults for this item type. (Detail, daily, weekly, and monthly stock charts,
stock text, weather maps, and weather text are all different item types and thus have different color and
font defaults.)

When you're done at the Financial Display Selection dialog box, click OK to save your display selections.
Click OK again at the Page Definition dialog box.

For more on the other parts of the Financial Display Selection dialog box:

* Display As

* Information Type
- Tickers

* Fonts

* Settings



Item (menu option)

The ltem menu on the menu bar gives you six menu choices on a drop-down menu. Click on the
choices below to learn more about each one.

Item
Edit Alt+Enter
Info Ctri+l
Previous
Next

Copy Ctrl+C
Zoom Ctrl+Z2
You can get to related pop-up item menus by clicking with the right mouse button on an item itself in the

viewing area. The choices on these pop-up item menus vary depending on which topic you're in.
Pop-up Item menu (in news)

Find...
Find Next

Collect Later
Collect Now
Clear Request
Copy

Agreement

Pop-up Item menu (in financial)

Pop-up Item menu (in weather)
Edit

Previous
Next




Help

There are several ways to get to on-line help in Rosebud, all typical of any Windows application.

* Help via the menu bar

The Help option on the Viewer menu bar gives you a drop-down menu of Help options, beginning with the
Help Contents screen. Other options (Search, for example) let you search for help on a specific
Rosebud topic.

* Help via the F1 key

Pressing F1 brings up a help screen dealing specifically with where you are in the program. For
example, if you're at the Folder Properties dialog box and press the F1 key, the help screen that appears
is about the Folder Properties dialog box.. From there you can browse through other help topics, or use
the Search button to find help on a specific topic.

® Help via the Help button

Some Rosebud screens have their own Help button. Clicking on it brings up a help screen dealing
specifically with where you are in the program.

If you'd like additional guidance in using Windows on-line help, check out your Windows manual or one of
the many third-party books available. Or click on Help on the Windows Program Manager menu bar and
select How to use Help.



File: New

The New command on the File menu lets you create a new .VWR file. The .VWR file stores the
information about how you've set folders up in the Viewer.

For example, if Scott and Megan use the same computer but don't track the same stocks or weather or
retrieve the same news articles, they can create individual .VWR files. When Scott loads the Viewer, he
can open his own .VWR file that remembers how his folders are set up (what stocks he tracks, what news
he reads, what colors his stock charts are, and so on). When Megan loads the Viewer, she opens

her .VWR file that remembers her folders.

To create a new .VWR file, set the folders up in the Viewer the way you want them, then click File Save
As to save the various settings (the configuration) under a new name.



File: Open

The Open command on the File menu lets you open a .VWR file (the file that remembers how your

version of the Viewer is set up).

You can create any number of .VWR files (normally, one for each user). Each time you load Rosebud's
Viewer, select File Open; you'll be taken to a File Open dialog box. Highlight the .VWR file you want and
click OK. (Use the Drives and Directories list boxes if the file you need is located in a different
subdirectory.)

Each time you open the Viewer, Rosebud will load the last .VWR file it used.



File: Save

The Save command on the File menu lets you save your .VWR file if you've made changes to your
Viewer setup. If you make changes to your Viewer setup, Rosebud will prompt you to save them when

you exit.
If you need to save your .VWR file under another name, use Save As instead of Save.



File: Save As

The Save As command on the File menu lets you save a .VWR file under a new name.

If you just need to save your existing .VWR file under the same name, you can use the Save command
rather than the Save As command.



File: Print

The Print command on the File menu lets you print the currently displayed page. The keyboard shortcut
is Ctrl-P.



File: Print Preview

The Print Preview command on the File menu lets you see what the currently displayed page will look like
when it prints.



File: Print Setup

When you select Print Setup from the File menu, the standard Windows Print Setup dialog box appears;
this is where you can select the printer, the page size and orientation, the paper source, and deal with a
number of other printer issues common to any Windows application.



File: Exit

The Exit command on the File menu lets you leave Rosebud. You can do the same thing by double-
clicking on the control-menu box (the box with the dash in the upper left corner of the Rosebud window)

or by pressing Alt-F4.



The Rosebud Viewer

The Viewer screen has four major elements.

* Folders - the vertical column of labeled file folder icons at the left edge of the screen
* Viewing area - the large area that takes up the right side of the Viewer

* Menu bar - the options across the top of the screen, just below the title bar

* Toolbar - the horizontal row of buttons just below the menu bar
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Topic: Weather

Weather is one of the topics Rosebud retrieves information on. (The others are Mail, News, and
Financial.) Each topic is represented by a tool on the toolbar and a choice on the Topic menu.

When you click on the Weather tool on the toolbar (or select Weather on the Topic menu) the folders in
the column at the left edge of the Viewer screen change to display the folders that have been set up
under the weather topic.

Rosebud comes to you with some folders already set up, so that you can see how it's supposed to work;
you can modify these default items, or create new ones.

Creating a new folder
Modifying an existing folder
Deleting an existing folder



Topic: Financial

Financial is one of the topics Rosebud retrieves information on. (The others are News, Mail and
Weather.) Each topic is represented by a tool on the toolbar and a choice on the Topic menu..

When you click on the Financial tool on the toolbar (or select Financial on the Topic menu) the folders in
the column at the left edge of the Viewer screen change to display the folders that have been set up
under the financial topic.

Rosebud comes to you with some folders already set up, so that you can see how it's supposed to work;
you can modify these default items, or create new ones.

Creating a new folder
Modifying an existing folder
Deleting an existing folder



Set defaults

Click here if you've set up a new color scheme and want it to be the default. Note that detail, daily,
weekly, and monthly stock graphs, stock text, weather maps, and weather text are all different item types
and thus can have different color and font defaults.

See Financial: Colors to learn more.



Folder: Delete

The Delete command on the Folder menu lets you delete an folder altogether. You'll be asked to confirm
the deletion.



Menu bar

This is the Viewer menu bar.

See Menu bar for more.



Folder: Move Up/Down

The Move Up and Move Down commands on the Folder menu let you rearrange the order of your folders.



Page: New

The Page New command lets you create a new page for a folder. You can do the same thing by
pressing Alt-N.

The Page Definition dialog box will display so that you can begin setting up a new page.



News Folder

The News Folder dialog box lets you name a folder and then specify what news articles you want to see
each time you click that folder; you also specify what order the articles should display in, and what
sources the articles should come from.

You also come to the News Folder dialog box to modify the way information displays on an existing news
folder.

The News Folder dialog box is divided into four general areas:
* Title

* Sort Order
*  What to display

* Include

News Folder

Title

Sort Order
1st 2nd 3id

DD Search Rating

Source [Reuters. UPI, etc.__]
3 | Headline
Date < Didest First ® Newest First

What to dizplay

- Betrieved Articles O Unretrieved Articles
] Unread Articles Only

Include

@ All Articles
) Selected Reporters
{ Selected Sources

| Epdent Mopoarbary I

Include all arhicles

{_* Search Existing Articles




Folder Properties

In the financial or weather topic, when you select Folder New or Folder Edit from the menu bar, a small
dialog box titled Folder Properties appears. This is the first step in creating a new financial or weather
folder.

= Folder Properties

Title

| 1] 4 I
'

It's also where you come if you want to change the wording of an existing financial or weather folder label.
You can also get to the Folder Properties dialog box by clicking the right mouse button on a financial or
weather folder and selecting New or Edit from the pop-up menu.

Type in the text you want to appear as the folder label; for example:
Hi-tech stocks
Sector stocks
Telecommunications stocks
Jim's stocks
Atlanta weather
Tucson weather
National weather summaries
Move on to Page Definition to set up the way you want the page of information to display.



Page Definition

The Page Definition dialog box appears:

*  When you click OK after you name a new financial or weather folder using the Folder Properties
dialog box.

*  When you select Page New or Page Edit from the menu bar.
*  When you click Alt-N or Alt E.
*  When you click on a newly-named folder that you haven't yet defined any pages for.

Use the Page Definition dialog box to define how your newly created page will be divided up, and what it
will contain:

* Page Definition: Layout
* Page Definition: Content

Move your mouse pointer over the dialog box below. When the arrow changes to a pointing hand, click
to learn more.

= Page Definition

Folder: Computer

Industry
Layout

Rows: 2z 1

Columns: 2

3
BN B

Content

Title

[Computer Stocks

| IBM [IBM] - Daily History |
| Intel [INTC] - Dailp Hiztory |

|Microchip Technology [MCHP) - Daily History |
| Microsoft [MSFT) - Daily History |




News Folder: Title

In the text box labeled Title, type in the text you want to use as a label for the folder.
Title

*-Philes

Examples:
Latest news
Movie reviews
Stuff about the X Files



News Folder: Sort Order: Headline

When you ask the Viewer to sort your retrieved articles by headline, the articles will display in the
alphabetical order of the headline text, like this:

"Americans investing more abroad"
"Astronauts return safely"

"Meryl Streep's new movie a real stretch"
"Mexican army reorganization in jeopardy"
"Republicans win again in Nebraska"

"Yen falls slightly after disputed election"

For information on the other sort order criteria:

* Search Rating
* Source

-

ate



News Folder: What to display

When you initially tell the Assignment Desk what articles you want a reporter to retrieve, you tell it how
many headlines to scan during its on-line search, and you set a limit to how many complete articles you
want it to retrieve. On certain reporters, you might limit what the reporter looks for by telling it to look for
certain text in article headlines.

When the Collection Agent retrieves the articles, it goes by the article limit you set, and only retrieves the
number of articles you told it to. But it retrieves all the headlines it found, even if it didn't get the articles
themselves.

Other headlines will be stored if you check the "Store headlines" check box; in that situation, Rosebud will
save headlines (up to the scan limit) for non-matching articles.

If you click on the Retrieved Articles radio button in the What to display section of the News Folder dialog
box, you're telling the Viewer to show you just the articles that have been retrieved.

If, on the other hand, you click on Unretrieved Articles, you're asking to see just the headlines of
unretrieved articles. Then if you see a headline in the displayed list that sounds interesting, you can tell
Rosebud to retrieve it, either right away, or during the next regularly scheduled logon.

If you check the Unread Articles Only check box, you're telling the Viewer to display only articles you
haven't read yet.



Folder: New

The New command on the Folder menu lets you create a new folder. You will create a new folder any
time you want to view different combinations of retrieved information.

When you select Folder New:
* If you're in the mail topic, you'll be taken to the Mail Folder dialog box.
* If you're in the news topic, you'll be taken to the News Folder dialog box.

* Ifyou're in financial or weather, you'll be taken to the Folder Properties dialog box.




What to display

You can ask Rosebud to show you the articles that you've asked it to retrieve, or the headlines for articles
that it didn't retrieve. (Why didn't it retrieve them? Two reasons: Because you set a limit on the number of
articles to retrieve, and there were more matching articles than the limit you set. Or because you have the
"Store headlines for articles that don't match" box checked.)

See News Folder dialog box: What to display to learn more about what the Viewer will display.



News Folder: Sort Order: Date

When you ask the Viewer to sort articles by date, it displays them in chronological order. You must

indicate whether you want oldest articles first or newest articles first, by clicking the appropriate radio
button.

For information on the other sort order criteria:
* Search Ratin
* Source

* Headline



Delete mail

How to delete a message
1. Highlight the message in the list in the Viewer.

2. Click Mail on the menu bar.

3. Click Delete. The message will be moved to the Wastebasket folder, where it will eventually be
deleted in accordance with your settings on the Settings tab of the Mail Settings dialog box in the

Assignment Desk.

Note: To REALLY delete a message, highlight it in the Wastebasket folder and select Delete.
It will be immediately deleted from your hard drive.



News Folder: Sort Order: Source

The news articles you've asked for in the Assignment Desk are retrieved from CompuServe, but
CompusServe itself gets them from a variety of sources (Reuters, UPI, etc.). Each article is identified as
to source, and you can therefore ask the Viewer to sort them by source. Sorting by source means all the
UPI articles will be grouped together, all the articles from AP will be grouped together, etc.

For information on the other sort order criteria:
* Search Rating
* Headline

¢ Date



News Folder: Sort Order

You can tell the Viewer to show you your news articles in a particular order, based on four criteria:
¢ Search Ratin
e Source

* Headline

-

ate

Sort Order
1st 2nd 3rd

DD Search Rating

Source [Reuters. UPI, etc_. ]
3 | Headline
1 Date () Oldest First ® Mewest First

The sort can be three levels deep. For example, you might sort your news articles first by date (either
oldest or newest first); thus all the articles dated March 12, 1995, would be grouped together. A
secondary sort within those March 12th articles might be based on which news source they came from;
thus all the UPI articles for March 12th would be grouped together. The third-level sort could then sort all
the March 12th UPI articles alphabetically based on the text of their headlines.




News Folder: Sort Order: Search Rating

When Rosebud looks for the articles you've asked for in the Assignment Desk, the search will find some
articles that are closer to what you asked for than others.

Each article is rated by how well it meets your search criteria; thus when you ask the Viewer to display
your articles based on search rating, you're asking to see the most relevant articles first.

For information on the other sort order criteria:
* Source

* Headline

HU
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Quotes in graph form

Your financial information can display in text form or as a graph. It may be difficult to understand the
graph for the first few days, until you get enough days of data to get the picture. Each day's data is a
colored vertical bar representing the price range for the stock for that one day; a black line across the bar
marks the day's closing figure.

The graph is in two parts. The top part is price; the bottom part is volume.

To change the fonts or colors, double-click on the displayed item to go the Financial Display Selection
dialog box. Select Font or Colors at the bottom.




News Folder: Include Selected Reporters

When the Selected Reporters radio button is selected, the button to the right says Select reporters; click
that button to see the Select Reporters dialog box. In the left-hand window you see a list of all the
reporters you've created in the Assignment Desk to retrieve articles about different subjects. Highlight a
reporter name and click the Add button (or double-click the name) and the reporter name is added to the
right-hand list of reporters.

When you're through selecting reporters, click OK to return to the News Folder dialog box.
For information on the other Include choices:

¢ All Articles

* Selected Sources

* Search Existing Articles



News Folder: Include

When you set up a News item folder, you can specify which articles, of all the articles that have been
retrieved, you want to see. Four radio buttons let you make your selection; you can only select one.

¢ All Articles
* Selected Reporters

¢ Selected Sources

* Search Existing Articles



Assignment Desk

The Assignment Desk is one of three principal components of Rosebud. It's the part that lets you
specify what information you want to retrieve and when you want to retrieve it.

The other two parts of Rosebud are the Collection Agent (which actually retrieves the information from
CompuServe) and the Viewer (a display that lets you look at the information that's been collected, and
create mail).




Page Definition: Layout

You can divide the viewing area (the "page") into smaller sections if you like, in order to display several
pieces of stock or weather information on the same page.

Using the scroll bars at the bottom and right edge of the Layout box, tell the Viewer how many rows and
columns (up to a maximum of five rows and/or five columns) to set up on this page.

+
3 4
+
« L 3

Note that each section (or cell) you create in the Layout box has a number, and a long narrow button with
a corresponding number appears in the Content section of the Page Definition dialog box. Each one of
these numbered cells is an item. A page can have one item on it, or it can have up to 25.

Click here to see how to specify what appears in that numbered section of the page.



News Folder: Include Selected Sources

When the Selected Sources radio button is selected, the button to the right says Select sources; click that
button to see the Select News Sources dialog box. In the left-hand window you see a list of all the news
sources available on CompuServe. Highlight a name and click the Add button (or double-click the name)
and the source name is added to the News Sources to Search list.

When you're through selecting sources, click OK to return to the News Folder dialog box.

NOTE: Keep in mind that here in the Viewer you are only able to see what has actually been
retrieved. For example, if you click on Football here in the Viewer but have not actually
retrieved any articles from the Football news source, you won't see anything from the Football
news source.

Use the Assignment Desk to specify what sources to retrieve from; use the Viewer to specify
from which of the retrieved sources you want to see articles.

For information on the other Include choices:

¢ All Articles

* Selected Reporters
* Search Existing Articles



News Folder: Include Search Existing Articles

When the Search Existing Articles radio button is selected, you can type text in the text box below the
button. The Viewer will then search through all the headlines of retrieved articles for the specified text.
For example, if you're interested in looking only at articles you've retrieved about earthquakes, type the
word earthquake in the search text box.

If there's an X in the Search Article Text check box, the Viewer will also search the first 500 characters of
the articles themselves (not just the headlines). Clearly this will take a bit longer than searching just the
headlines. To uncheck the Search Article Text check box, click in it once.

For information on the other Include choices:

* All Articles

* Selected Reporters
* Selected Sources



Folder title

The text you type in the Title text box (on the Folder Properties dialog box for the weather and financial
topics; on the News Folder dialog box for a news topic) is what displays as the folder label.



Replying to a mail message

The Reply to Mail Message dialog box (below) lets you reply to an existing message. It looks much like
the Create Mail dialog box except that it includes the text of the original message, and certain information
taken from the message you're replying to is already filled in.

How to reply to a message

1. Inthe Viewer, click on the In Box (or whatever folder the existing message is in) to see a list of
messages at the top of the viewing area.

In the list of messages, highlight the message you want to reply to.

On the menu bar, click on Mail, then Reply (or click the Reply tool on the toolbar). The Reply to Mail
Message dialog box appears, with the From, To, and Subject lines already filled in and the original
message displayed in the upper part of the text entry area.

Add CC or BCC recipients, and change the Subject line if you like.

Click in the lower text entry area and type your reply. You can also import the reply text; click on the
Import File button and select the .TXT file to import.

6. To send the reply immediately, click the Send Now radio button.
To send the reply on Rosebud's next scheduled run, click the Send Later radio button.
7. Click OK.

Move your mouse over the graphic below; when the pointer changes to a pointed hand, click to learn
more.

Reply To Mail Message
Mancy Wright> EEEEE INEE

1 | Magee, Marshall>MH5 :MARSHALL&®MAGEE

Subject: |HEZ DOC and HLP files

Thanks Mancy. That iz all we need until next nday.
Thanks for helping us meet today's deadline.

Later....Marshall

[ |

Import File

) Send How
® Send Later
) Store In

|Hail Drafts |i| []Send as Shown ] Hotify of Receipt




News Folder: Include All Articles

When the All Articles radio button is selected, all retrieved articles display (in the order you've specified in
the Sort order section of this dialog box).

For information on the other Include choices:

* Selected Reporters
* Selected Sources

* Search Existing Articles



Fonts tab

Click here to bring the Fonts tab to the front, then use the Change button to change the fonts on the
graphs or text that the Viewer displays.

See Financial: Fonts to learn more about changing fonts.



Page Definition: Content

When you click once in one of the numbered cells in the Layout box, the cell becomes shaded and the
corresponding button in the Content section becomes active (indicated by the dotted border around the
words * Undefined *).

Click once in the text box labeled Title and type in the name of this page. This is the wording that will
display at the top of the viewing area when this folder is selected. For example, if the folder's title is
Consumer Stocks, you might want to create a page for that folder titled General Electric and another page
titled Pepsico.

Each page can be divided into items. For example, you might divide the GE page into two items: daily
GE guotes in text form at the top, and daily GE guotes in graph form in the lower half.

Click on the appropriately numbered * Undefined * button (or simply double-click the shaded cell in the

Layout box) to see the Financial Display Selection or Weather Display Selection dialog box, where you
can tell the Viewer how you want the item (the stock/weather information) displayed in the shaded part of

the page.

NOTE: The wording that appears on the long buttons in the Content area is automatically
inserted; it's a function of how the item is referred to internally).

Content
Title
[Computer Stocks |
1 | IEM [IBM] - Daily History |
2 | Intel (INTC) - Daily History |
3 |Microchip Technology [MCHP) - Daily History |
4 | Microsoft [MSFT] - Daily History |

Once an item has been set up (as either a full page all by itself, or as part of a page), you can bring up
the display selection dialog box by simply double-clicking on the item in the viewing area.



Financial Display Selection

This is where you tell the Viewer how to display the stock information that's been retrieved. The top half
of this dialog box lets you tell the Viewer what to display; the bottom half lets you tell the Viewer how to
display it. When you finish making you display selections on this dialog box, click OK to save the
information, then click OK again back at the Page Definition dialog box.

Top half (what to display):
* Information Type

* Display As
* Tickers

Bottom half (how to display it):

* Colors
* Fonts
* Settings

Move your mouse pointer over the dialog box below. When the arrow changes to a pointing hand, click
to learn more.

= Financial Display Selection

Information Type Ticker Symbols

DJ - 30 Industrials [DJ 30] +
Ford Motor [F]
Gillette [G]
General Electrnic [GE]
General Motors [GM]
GTE [GTE]
Home Depot [HD
D lEHt Dail}l |£I e L
) Graph

Display As

Backaground Color
Border Color

Title Color

Text Color
Yolume Bars
Price Color

DBfe2 DB/ OBf24 DBJZG DB/ZH OB/ZH OF | Change I |Qse Defaultsl |§et Defaults |

Colors 1 Forts l Seftings J




Weather Display Selection

This is where you tell the Viewer how to display the weather information that's been retrieved. The top
half of this dialog box lets you tell the Viewer what to display; the bottom half lets you tell the Viewer how
to display it.

Top half (what to display):

¢ | ocation

*  Weather Types
Bottom half (how to display it):

* Colors

* Fonts

Move your mouse pointer over the dialog box below. When the arrow changes to a pointing hand, click
to learn more.

= Weather Display Selection

Location: |Atlanta, GA. USA |£I

Weather Types

State forecast [Text] + I
Regional summary [Text]

Precipitation probability [Text]
Sports and recreation [Text)

Marine forecast [Text]
Severe weather alert  [Text

Cancel

|G atollito Ihd and

Colors

Backaground Color
Title Color

Shorl Tewm Foncaet for Adests G

Change I |use Defaultsl |§et Defaults |

Colors 1 Fonts J




Sort Order
When you look at the news articles you've asked Rosebud to retrieve, you can look at them in any order,
based on four criteria:

Search rating (how closely the article matches what you asked for)

Source (UPI, for example)

Headline (alphabetical)

Date (either oldest or newest first)

See News Folder: Sort Order to learn more about sort order.



Financial preview area

This area reflects the colors and fonts you choose for your graphs or text.



Financial settings

The bottom half of the Financial Display Selection dialog box is made up of three tabs: Colors, Fonts, and
Settings. Note the labeled extensions of each tab at the bottom of the dialog box. Click on the
extension labeled Settings to bring the Settings tab to the top.

The Settings tab lets you specify whether you want to see all retrieved quotes, or only those from the last
x number of periods. When you click on the Show last button, you can select the number of periods (up
to 30).

When you're done at the Financial Display Selection dialog box, click OK to save your display selections.
Click OK again at the Page Definition dialog box.

For more on the other parts of the Financial Display Selection dialog box:

* Display As

* Information Type
*  Tickers

» Colors

* Fonts




Financial: Information Type

You can display your stock information either by individual stocks or by portfolio.
Information Type

i PortFolio

*  When you choose Ticker Symbol, a list of stock names and ticker symbols appears in the list box
labeled Ticker Symbols. These are all the stocks that came with Rosebud, or that you entered
yourself in the Assignment Desk. Click on the particular stock you want to see displayed.

*  When you choose Portfolio, you get a list of financial reporters you set up and entered Portfolio
information on in the Assignment Desk. Select the one you want to see.

When you're done at the Financial Display Selection dialog box, click OK to save your display selections.
Click OK again at the Page Definition dialog box.

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

For more on the other parts of the Einancial Display Selection dialog box:

* Display As
- Tickers
» Colors
* Fonts




Financial: Display As

You can display your stock information as text or as a graph. Click the appropriate button under Display
As. Note the preview area changes to show you how the two options look.

In either case, you can use the drop-down list to the right of the Text and Graph buttons to choose how
detailed you want the displayed information to be:

¢ Detail - When you choose this option, you'll see every quote that's been retrieved. That is, if you've
told the Assignment Desk you want to check stocks every hour, Detail shows you all these hourly
quotes. You can collect detailed quotes as often as every 15 minutes.

* Daily - When you choose this option, Rosebud shows you one summarized figure for the day.
*  Weekly - When you choose this option, Rosebud shows you one summarized figure for the week.

* Monthly - When you choose this option, Rosebud shows you one summarized figure for the month.

When you're done at the Financial Display Selection dialog box, click OK to save your display selections.
Click OK again at the Page Definition dialog box.

For more on the other parts of the Financial Display Selection dialog box:
* Information Type

¢ Tickers
* Colors
* Fonts




Financial: Tickers

The Tickers list box on the Financial Display Selection dialog box lists all the stocks (and their ticker
symbols) that have been defined in the ticker symbol list in the Assignment Desk.

When you're done at the Financial Display Selection dialog box, click OK to save your display selections.
Click OK again at the Page Definition dialog box.

For more on the other parts of the Financial Display Selection dialog box:

* Display As

* Information Type
»  Colors

* Fonts

* Settings



Collection Agent

The Collection Agent is one of three principal components of Rosebud; it's the part that actually does the
collecting of the information you want. It logs on to CompuServe and retrieves information many times
faster than you can do it manually. The information it retrieves goes into various databases maintained
by Rosebud on your computer. These databases can be accessed by third-party applications.

The other two parts of Rosebud are the Assignment Desk (where you tell Rosebud what information you
want, and when) and the Viewer (a display that lets you look at the information that's been collected, and

create mail messages).



Weather: Weather Types

The Weather Types list box shows you what maps or text information have been retrieved for the location
you specified. Highlight the one you want to display on the item you're setting up.

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

For more on the other parts of the Weather Display Selection dialog box:

* Location
* Colors
* Fonts

See Item: Previous/Next to learn how to scroll through earlier weather maps and radar views.



Weather fonts

The bottom half of the Weather Display Selection dialog box is made up of two tabs: Colors and Fonts.
Note the labeled extensions of each tab at the bottom of the dialog box. Click on the extension labeled
Fonts to bring the Fonts tab to the top.

The Fonts tab lets you change the fonts (typefaces) used in the display. In the list box on the right,
double-click on the name of the part of the viewing area you want to change (Title Font, Text Font, etc.) to
bring up a Font dialog box. (You can also get to the Font dialog box by clicking on the viewing area
name and then clicking on Change.)

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

In the Font dialog box, select a new font, font style, and font size from those shown as available on your
system. Click OK. If you decide you want the original fonts back, click on Use Defaults. If, on the
other hand, you set up a font combination you like and you want it to be the new default, click on the Set
Defaults button; you'll get a Set Defaults dialog box asking you to confirm that you do in fact want the new
font settings to become the new defaults for this item type. (Detail, daily, weekly, and monthly stock
graphs, stock text, weather maps, and weather text are all different item types and thus have different
color and font defaults.)

For more on the other parts of the Weather Display Selection dialog box:

* Location
* Weather Types
* Colors

See Item: Previous/Next to learn how to scroll through earlier weather maps and radar views.



Information type

These two radio buttons let you choose between looking at just one stock, or at your whole portfolio.

If you select Ticker, you can choose the stock you want to see from among a list of stocks you've asked
the Assignment Desk to retrieve.

If you select Portfolio, you can choose the portfolio you want to see from among a list of portfolios you've
defined in the Assignment Desk.

See Financial: Information Type to learn more.



Weather: Location

The Location text box on the Weather Display Selection dialog box lets you choose the geographic
location for which you want to see weather information on the item you're setting up.

Click on the arrow at the right end of the text box to see the list of locations for which information has
been retrieved; click on your choice. Then move on to select the Weather Types you want to see for that
location.

For more on the other parts of the Weather Display Selection dialog box:
*  Weather Types
e Colors

* Fonts

See ltem: Previous/Next to learn how to scroll through earlier weather maps and radar views.



Weather colors

The bottom half of the Weather Display Selection dialog box is made up of two tabs: Colors and Fonts.
Note the labeled extensions of each tab at the bottom of the dialog box. Click on the extension labeled
Colors to bring the Colors tab to the top.

The Colors tab lets you change the colors of the display. In the list box on the right, double-click on the
name of the viewing area you want to change (Background Color, Text Color, etc.) to bring up a Color
dialog box. (You can also bring up the Color dialog box by clicking on the viewing area name and then
clicking on Change.)

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

In the Color dialog box, click on the color you want and click OK. If you decide you have horrible color
sense and want the original colors back, click on Use Defaults. If, on the other hand, you set up a
particularly fetching color combination and you want it to be the new default, click on the Set Defaults
button; you'll get a Set Defaults dialog box asking you to confirm that you do in fact want the new color
settings to become the new defaults for this item type. (Detail, daily, weekly, and monthly stock graphs,
stock text, weather maps, and weather text are all different item types and thus have different color and
font defaults.)

For more on the other parts of the Weather Display Selection dialog box:

* Location
* Weather Types
* Fonts

See Item: Previous/Next to learn how to scroll through earlier weather maps and radar views.



Page: Edit

How to edit a page

To edit a page, click once on the page and select Page Edit to bring up the Page Definition dialog box.
The Page Definition dialog box lets you specify what items appears on a page.

You can also get to the Page Definition dialog box by clicking on the page and pressing Alt-E, or by
selecting Folder Edit from the menu bar and going through the Folder Properties dialog box.

NOTE: If you want to change how the chosen items look on the page, double-click in the
numbered area in the Layout part of the Page Definition dialog box, or click on the long
numbered button. Or use the ltem Edit command rather than the Page Edit command.

If you want to change the wording of a folder label, use the Folder Edit command rather than
the Page Edit command.



Page: Delete

Selecting Page Delete lets you delete the displayed weather or financial page. (You can get to the same
place by pressing Alt-D.) You'll be asked to confirm the deletion.



Page: Previous/Next

Selecting Previous from the Page menu (or pressing Ctrl-PgUp) moves you to the previous page of
information in this folder. You can also just click on the page title in the list of pages in the upper portion of
the viewing area.

Selecting Next (or pressing Ctrl-PgDn) moves you to the next page.



Headline

When you tell Rosebud to sort by headline, the Viewer shows you the articles with the headline text in
alphabetical order.



Item: Edit

The ltem Edit command lets you make changes to an existing item.
How to edit an item

To edit an item, double-click on the item. You can also click once on the item you want to edit, then
select ltem Edit from the menu bar, or press Alt-Enter.

Depending upon which topic you're in, you'll be taken to the Financial Display Selection dialog box or the
Weather Display Selection dialog box, where you can make changes to the content and layout of this
item. If you're in a news topic, you get the News Display Selection dialog box, where you can make
changes to the colors and fonts. If you're in mail, you get the Mail Display Setup dialog box, where you
can make changes to the colors and fonts.

You can also get to these same display selection dialog boxes by working your way through Folder Edit
and the Folder Properties and Page Definition dialog boxes.

NOTE: If you just want to change the wording of the folder label, use the Folder Edit
command to get to the Folder Properties dialog box.



Item: Info

The ltem Info command brings up the Item Information dialog box. The actual information you see
depends on which topic you're in.

The keyboard shortcut is Ctrl-I (the letter "I" as in Information).




Change button

Once you highlight a chart area (Text Color, Background Color, etc.) you want to change, click the
Change button to bring up the Color dialog box.

See Financial: Colors to learn more.



Topic: News

News is one of the topics Rosebud retrieves information on. (The others are Mail, Financial and
Weather.) Each topic is represented by a tool on the toolbar and a choice on the Topic menu.

When you click on the News tool on the toolbar (or select News on the Topic menu) the folders in the
column at the left edge of the Viewer screen change to display the folders that have been set up under
the news topic.

Rosebud comes to you with some folders already set up, so that you can see how it's supposed to work;
you can modify these default items, or create new ones.

Creating a new folder
Modifying an existing folder
Deleting an existing folder



Mail: In Box

When Rosebud retrieves your e-mail from CompuServe, it puts the message in the In Box folder in the
Viewer, and displays a notification message on your screen. (For more on the message window, see

Message alert.)

When you click on the In Box, the top part of the viewing area lists the subject, date, and sender of the
messages in your In Box. If a message included an attachment, the envelope icon at the left edge has a
diskette icon attached to it.

(1 Printing Help files? 09Jun1995 10:14am Handal DePriest> 4|
[1Re: Help Files 08Jun1995 06:33pm Magee, Marshall>
[1Re: Back invoices 07Jun1995 06:54pm Mancy Wright> :I
[1Re: Back invoices 07Jun1995 02:43pm Pancoast, Judy>
(g 06/07 Dr W log 07Jun1995 09:45am MNancy Wright>
| N = P oL 1l o 1000 Oi-2 4o Rlooce s Y hliobis *
To see the text of a message
. Click once on a message to display it in the lower part of the Viewer.
. Click twice to bring the full message up in the Edit/View Mail dialog box. The Eidt/View Mail

dialog box also lets you see the CC and BCC recipients of the message (information not visible at the
Viewer screen).

To sort the list of messages using the toolbar

. Click the Sub tool to sort the list alphabetically by subject line.

*  Click the "counterclockwise" clock to sort by date (newest first).
* Click the "clockwise" clock to sort by date (oldest first).

* Click the Frm tool to sort the list alphabetically by sender.
To reply to a message



Mail Folder

The Mail Folder dialog box lets you create (or edit) a mail folder.

1. Enter the folder name; this name is what will appear next to the file folder icon, and in any list of your
folders.

2. Enter the name of the directory where you want this folder stored on your hard drive.

3. Click OK to return to the Viewer.

Mail Folder

Folder Hame: |

Directory Hame: |

Exizting Mail Folders

Rosebud
Internet
Mizcellany




Mail: Sent Mail

Click on Sent Mail to see a list of messages you've sent.

You can move a sent message to the Wastebasket folder. Highlight the message in the Sent Mail list,
select Mail from the menu bar, select Move, then select Wastebasket. The message will stay in the
Wastebasket until Rosebud empties it.

If you don't move a message to the Wastebasket yourself, Rosebud deletes it automatically after a certain
number of days. You specify the number of days in the Assignment Desk. Highlight the Mail topic and
click Change. At the Settings tab on the Mail Settings dialog box, set the number of days in the Remove
Sent Folder Items line. The default is 5 days.



Topic: Mail

Mail is one of the topics Rosebud retrieves. (The others are News, Financial and Weather.) The mail
topic differs a bit from the other three topics, since you can create mail as well as receive it; by contrast,
you can only receive news, weather, or financial information. Thus the mail topic in the Viewer has
additional features that deal with the creation and management of mail messages.

Creating a new mail message

Replying to a mail message

Like the other three topics, the mail topic is represented by a tool on the toolbar and a choice on the Topic
menu. When you click on the Mail tool (or select Mail on the Topic menu) the folders in the column at the
left edge of the Viewer screen change to display the folders for the mail topic.

Rosebud comes to you with some basic mail folders already set up.

* InBox
- OutBox
¢ Sent Mail
¢ Mail Drafts

* Wastebasket

Creating a new folder
Modifying an existing folder
Deleting an existing folder
Mail Display Setup



Mail: Mail Drafts

How to create delayed outgoing mail

When you want to prepare a message but not send it right away, click the Mail Drafts folder, then click
Mail on the menu bar and select Create. You're taken to the Create Mail dialog box.

Clicking on Mail Drafts also displays a list of mail messages you've written but not sent. When you're
ready to send a message, highlight it and click on Mail on the menu bar, and select Send Now or Send
Later, then click OK.

Send Now - Rosebud will log on to CompuServe immediately and send the message.

Send Later - Rosebud will send the message at the next regularly scheduled logon. (Another way to
send the message at the next regularly scheduled run is to highlight the message in the Mail Drafts
list, select Mail on the menu bar, click Move and then select Out Box.)

In either case, after the message is sent, it appears in the Sent Mail folder list, where it will be deleted in
accordance with your settings on the Settings tab of the Mail Settlng dialog box in the Assignment Desk.

The Mail Drafts folder is useful for holding "templates" or other reusable text that you might send
frequently. Create the text, store it in the Mail Drafts folder, then call it up and address or edit it as
needed.



Mail: Wastebasket

When you click on the Wastebasket folder, you see a list of messages that you've put in the Wastebasket
for deletion.

The messages won't actually be deleted until later. How much later depends on what you've set on the
Settings tab in Mail Settings in the Assignment Desk, under Remove wastebasket items older than x
days.

How to move a message to the Wastebasket

Highlight the message on the list at the top of the viewing area in any mail folder.
Click Mail on the menu bar.

Select Move.

Click on Wastebasket.

Click OK.

How to delete a mail message manually

ok BN~

1. Highlight the message on the list at the top of the viewing area in the Wastebasket folder.
2. Click Mail on the menu bar.

3. Select Delete and confirm the deletion. Mail removed in this manner is actually gone from your hard
drive.



Item: Previous/Next

If you're working with items that can have "historical" information (weather for prior days, for example),
selecting Previous from the ltem menu moves you to earlier information.
Selecting Next moves you to later information.

You can do the same thing by clicking on the arrows at the end of the horizontal scroll bar at the bottom of
the screen. The display moves through previous maps (do it fast and you can pretend it's the six o'clock

weather).



Toolbar

The Viewer toolbar contains eight tools that are common to all four topics (Mail, News, Financial, and
Weather). When you move your mouse pointer over a tool and hold it there briefly, fly-over help
identifies the tool.

Click on the buttons below to learn more.

HEEE] 2E e

Click to see tools specific to the mail and news topics.




Include

The radio buttons here let you tell the Viewer which articles to show you.

See News Folder: Include to learn more.



Financial fonts

The bottom half of the Financial Display Selection dialog box is made up of three tabs: Colors, Fonts, and
Settings; note the labeled extensions of each tab at the bottom of the dialog box. Click on the extension
labeled Fonts to bring the Fonts tab to the top.

The Fonts tab lets you change the fonts (typefaces) used in the display of your stock information. In the
list box on the right, double-click on the name of the part of the viewing area you want to change (Title
Font, Text Font, etc.) to bring up a Font dialog box. (You can also get to the Font dialog box by clicking
on the viewing area name and then clicking on Change.)

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

In the Font dialog box, select a new font, font style, and font size from those shown as available on your
system. Click OK. Note that the preview area changes to reflect your new font choices. If you decide
you want the original fonts back, click on Use Defaults. If, on the other hand, you set up a font
combination you like and you want it to be the new default, click on the Set Defaults button; you'll get a
Set Defaults dialog box asking you to confirm that you do in fact want the new font settings to become the
new defaults for this item type. (Detail, daily, weekly, and monthly stock charts, stock text, weather
maps, and weather text are all different item types and thus have different color and font defaults.).

When you're done at the Financial Display Selection dialog box, click OK to save your display selections.
Click OK again at the Page Definition dialog box.

For more on the other parts of the Financial Display Selection dialog box:
* Information type

* Display As
* Tickers
* Colors

* Settings



Folder: Edit

The Edit command on the Folder menu lets you change things about an folder.

For a mail folder: \When you select Folder Edit, the Mail Folder dialog box appears. You can then
modify the name and location of the folder.

For a news folder: When you select Folder Edit, the News Folder dialog box appears. You can
then modify what displays when you select this news folder, using the same options on the News
Folder dialog box that you used when you created the folder from scratch. (To modify the colors and
fonts on a news page or item, select ltem Edit or double-click on the page or item.)

For a weather or financial folder: \When you select Folder Edit, the Folder Properties dialog box
appears and you can modify the wording of the folder label. (To modify the actual layout or content
of a weather or financial page or item, select Page Edit or ltem Edit rather than Folder Edit.)



Delete

If this button is active, you can click it to delete the displayed message.



Settings tab

Click here to bring the Settings tab to the front so that you can tell the Viewer whether to show you all
your stock quotes, or only the last so many (up to 30).

See Financial: Settings to learn more about changing settings.



Source

Articles on CompuServe come from various news sources (UPI, AP, etc.). When you tell Rosebud to sort
by source, all articles from the same source are grouped together.

See News Folder: Sort Order: Source to learn more about sorting by source.



All articles

When you select this button, the Viewer shows you all retrieved articles.

See News Folder: Include All Articles to learn more.



Date

Select Oldest first or Newest first to see articles in date order.



Search Rating

When you tell Rosebud to sort by search rating, you see the articles that best match your search criteria
first.

See News Folder: Sort Order: Search Rating to learn more about sorting by search rating.



Viewing area (lower portion)

This is the part of the viewing area that displays what you want to see.

See Viewing area for more.



Viewing area (upper portion)

This is the part of the viewing area that lists the titles of all pages in this folder. Click on a page title to
see that page.

See Viewing area for more.



Folder

A folder contains related information retrieved from CompuServe. The information in a given folder can be
displayed on a full page (the viewing area) or as items on part of a page. Use the Page and Item options
on the menu bar to set up the display.

See Folders to learn more.



Chart areas

This is a list of the chart areas whose color you can change. Click on the name of the area you want to
change, then click the Change button to bring up the Color dialog box. Click on a new color and click
OK; note that the preview area changes to reflect your new color choice.

See Financial: Colors to learn more.



Use defaults

Click this button if you make a mess of the graph colors and want to start over with the default colors.
Note that detail, daily, weekly, and monthly stock graphs, stock text, weather maps, and weather text are
all different item types and thus can have different color and font defaults.

See Financial: Colors to learn more.



Selected Reporters

When this radio button is selected, the button next to it lets you select from reporters you've created in the
Assignment Desk about different subjects. You'll only see articles from the selected reporters.

See News Folder: Include Selected Reporters to learn more.



Selected Sources

When this radio button is checked, the button next to it lets you select from the various news sources
available on CompuServe. You'll only see articles from the selected sources.

See News Folder: Include Selected Sources to learn more.



Search Existing Articles
When this radio button is checked, you can search for specific text in the headlines of retrieved articles.
You'll then only see those articles whose headlines contain the text.

If you also check Search Article Text, the Viewer will look in the first 500 characters of all downloaded
articles for the text, as well as in the headlines.

See_News Folder Include Search Existing Articles to learn more.
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Colors tab

Click here to bring the Colors tab to the front, then use the Change button to change the colors on the
graphs or text that the Viewer displays.

See Financial: Colors to learn more about changing colors.



Content

In the Content part of the Page Definition dialog box, name the page, then use the long buttons to move
on to define what displays on the items on the page.

See Page Definition: Content for more.



Display As

Click one of the two radio buttons to tell the Viewer whether to display your stock information as text, or
as a graph.

See Financial: Display As to learn more.



How much detail do you want?

This drop-down list box lets you tell the Viewer whether to show you detail quotes (the ones Rosebud
gets for you every 15 minutes or every hour or whatever) or a daily summary, weekly summary, or
monthly summary.

See Financial: Display As to learn more.



Ticker symbols

This list box displays all the stocks (and ticker symbols) you've set up in the Assignment Desk. Select
the stock you want to see on the item you're setting up.

See Financial: Tickers to learn more.



Location

Use this drop-down list box box to see the list of geographic locations for which weather information has
been retrieved; click on your choice.

See Weather Location to learn more.



Weather types

This list box shows you what maps or text information have been retrieved for the location you specified.
Highlight your choice.

See Weather: Weather Types to learn more about weather types.



Weather preview area

This area reflects the colors and fonts you choose for your graphs or text.



Colors tab

Click here to bring the Colors tab to the front, then use the Change button to change the colors on the
graphs or text that the Viewer displays.

See Weather colors to learn more about changing colors.



Fonts tab

Click here to bring the Fonts tab to the front, then use the Change button to change the fonts on the
graphs or text that the Viewer displays.

See Weather fonts to learn more about changing fonts.



Change button

Once you highlight a chart area (Text Color, Background Color, etc.) you want to change, click the
Change button to bring up the Color or Font dialog box.

See Weather colors and Weather fonts to learn more.



Use defaults

Click this button if you make a mess of the graph colors or fonts and want to start over with the default
colors or fonts. Note that detail, daily, weekly, and monthly stock graphs, stock text, weather maps, and
weather text are all different item types and thus have different color and font defaults.

See Weather colors and Weather fonts to learn more.



Set defaults

Click here if you've set up a new color scheme or font selection and want it to be the default. Note that
detail, daily, weekly, and monthly stock graphs, stock text, weather maps, and weather text are all
different item types and thus can have different color and font defaults.

See Weather colors and Weather fonts to learn more.



Chart areas

This is a list of the parts of the viewing area whose color or font you can change. Click on the name of
the area you want to change, then click the Change button to bring up the Color or Font dialog box.
Click on a new color or font and click OK; note that the preview area changes to reflect your new choice.

See Weather colors and Weather fonts to learn more.



Folder: Prev/Next

The Prev Folder and Next Folder commands on the Folder menu let you move from folder to folder. The
keyboard shortcuts are Alt-PgUp and Alt-PgDn.




Folder Properties

The dialog box that lets you name the financial or weather folder you're setting up, or edit the wording on
an existing financial or weather folder.

See Folder Properties to learn more.



Pop-up menu

A small menu that appears when you click on a certain spot. The options on a pop-up menu are often the
same ones that can be reached via the menu bar at the top of your screen; they're just handier in a pop-

up.



Mail

Messages you send and receive via CompuServe. Often called e-mail (for "electronic mail") to
distinguish it from hard-copy mail. One of four topics currently supported by Rosebud.

See Mail for more.



News

Articles you've asked Rosebud to retrieve for you from CompuServe. You use the Rosebud Assignment
Desk to tell Rosebud exactly which articles to retrieve, then you look at them in the Viewer. News is one
of four topics currently supported by Rosebud.

See News for more.



Financial

Stock, bond, and mutual fund information retrieved for you from CompuServe. You use the Rosebud
Assignment Desk to tell Rosebud exactly what financial information to retrieve, then you look at it in the
Viewer. Financial is one of four topics currently supported by Rosebud.

See Financial for more.



Weather

Weather maps or text data (temperatures, rainfall figures, and the like) retrieved for you from
CompuServe. You use the Rosebud Assignment Desk to tell Rosebud exactly what weather information
to retrieve, then you look at it in the Viewer. Weather is one of four topics currently supported by
Rosebud.

See Weather for more.



Drop-down menu

A list of choices that drops down from any of several options along a menu bar at the top of your screen.



Keyboard shortcut

A key (or key combination) that does the same thing as certain mouse clicks. Once learned, a keyboard
shortcut is usually faster than using the mouse.



File Open dialog box

Standard Windows dialog box that displays a list of files in the current directory. The actual title of the
dialog box may vary depending upon the context, but the layout will consistent. Often the list of files is
filtered; that is, it only shows certain types of files. A Drive list and a Directory list let you look for a file
elsewhere on your system if it's not in the current directory.



.VWR file

A Rosebud Viewer configuration file that stores information about how you've set up the Viewer.



Tab

A layered section of a dialog box with a labeled extension, similar to a divider in a filing cabinet.

Clicking

on the labeled extension brings the tab to the front, where it provides or asks for information. The labeled
extensions can be along the top, sides or bottom of the tabs; in the example below, they're along the

bottom.
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Detailed stock quotes

All the quotes that Rosebud retrieves for you in a day, at the interval you specify in the Assignment Desk.
Quotes can be retrieved as often as every 15 minutes.



Daily stock summary

Average of all the detailed quotes for the day for a particular stock.



Weekly stock summary

Weekly average of all the daily summaries for a particular stock.



Monthly stock figures

Monthly average of all the weekly summaries for a particular stock.



Text

Weather or financial information displayed as columns of figures (dollar amounts, temperatures, rainfall
amounts, and the like) instead of as charts or graphs.

See Quotes in text form for more.



Graph/Map

Weather or financial information displayed as a chart, graph, or map instead of as columns of figures
(dollar amounts, temperatures, rainfall amounts, and the like).

See Quotes in graph form for more.



Ticker symbols

The short version (usually three or four letters) of the name of a stock or mutual fund by which it's known
on its stock exchange.



Sources

News sources such as Business News, Entertainment News, Miss Manners and the like. The list of
available sources is maintained by Rosebud automatically.



Radio button

In a Windows dialog box, a circle next to each of a group of mutually exclusive options. A black dot in
the middle of the circle means the button is selected. Only one radio button in the group can be selected

at a time.



Mail: Out Box

When you create a mail message (or forward information), Rosebud stores it in the Out Box until the next
scheduled send, when Rosebud checks the Out Box for any outgoing items. Click on the Out Box folder
to see a list of messages waiting to be sent.

How to create outgoing mail

1. Click Mail on the menu bar.

2. Select Create.

The Create Mail dialog box will appear.

Once a message has been sent, it's automatically put in the Sent Mail folder; the message count in the
Out Box decreases by one, and increases by one in Sent Mail.

How to move a message to the Out Box
1. Highlight the message in the list.

Click Mail on the menu bar.

Select Move.

Click on Out Box in the list that appears.
Click OK.

o > DN



Quotes in text form

Your financial information can display in text form or as a graph. The text form is a simple table in
reverse chronological order; the newest information is listed first.

To change the display font of the title or the body of the table, double-click on the displayed item to go the
Financial Display Selection dialog box. Select Fonts at the bottom.




News Display Selection

This is where you tell the Viewer what fonts and colors to use to display the news articles that have been
retrieved.

* Colors

* Fonts

Move your mouse over the graphic; when the pointer changes to a pointing hand, click to learn more.
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Layout

Use the layout part of the Page Definition dialog box to tell the Viewer how many items to put on this
page.
See Page Definition: Layout for more.



Mail Display Setup

This is where you tell the Viewer what fonts and colors to use to display your mail messages.
e Colors

* Fonts

Move your mouse over the graphic; when the pointer changes to a pointing hand, click to learn more.
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Creating mail

The Create Mail dialog box is where you come to type a new outgoing message.

NOTE: To reply to an existing mail message you've received (rather than create a message
from scratch) see Replying to a mail message.
How to create a new outgoing message

1. In the Viewer, click Mail on the menu bar.

2. Click Create. The Create Mail dialog box (below) appears. You can also get to this dialog box by
clicking the Create tool (the eight one from the right on the toolbar).

3. Click on To to bring up the Primary Recipients dialog box, where you can enter a new address directly
or select one from your Address Book. Enter a CC or BCC address if desired.

Enter a subject line.

Type your message, or import a previously created message.

To send the reply immediately, click the Send Now radio button.

To send the reply on Rosebud's next scheduled run, click the Send Later radio button.
7. Click OK.

Move your mouse pointer over the dialog box below; when the arrow changes to a pointing hand, click to
see what goes in the various parts of the dialog box.

Cancel

Import File

) Send Mow
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Edit Address Book

When you click Edit Address Book at the bottom of the Address Book (or Primary Recipients or CC
Recipients) dialog box, the Edit Address Book dialog box appears.

The Edit Address Book dialog box lets you add, edit, or delete entries in your Address Book. You can also
import an existing list of CompuServe Address Book names and address.

Move your mouse over the dialog box below; when the pointer changes to a pointing hand, click to learn
more.

Edit Address Book

Mames & Addresses
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To

Click on the To button to bring up the Address Book, where you can enter a name directly or select from
one already there.

See To, CC, and BCC recipients for more.



CC and BCC

Click CC or BCC to get to the Address Book, when you can enter a new name directly or select an
existing one.

See To, CC, and BCC recipients for more.



Forward

If this button is active, you can click it to forward the displayed message to another address.

See Forward for more.



Subject

Enter a subject line here.



Attachments

Click here to attach a file to your outgoing message.

See Attachments for more.



Send

Use these Send radio buttons to have Rosebud send the message.
» Select Send Now (and click OK at the upper right) to send the message immediately.

+ Select Send Later (and click OK at the upper right) to send the message on Rosebud's next
scheduled run.



Store in

Click the Store in radio button when you're not ready to send the message yet. Click the arrow at the
end of the text box to see a list of available mail folders where you can store this message until you're
ready to send it.



Reply
If this button is active, you can click it to reply to a message.

See Replying to a mail message for more.



Import file

Click the Import button if you have text in a .TXT file that you want to include in the message. You get a
standard file selection dialog box that lets you move to the proper drive and/or directory to find the file.

See Importing a text file for more.



Send as shown

Check Send as Shown if you want the line endings in your message to remain the same when the
message is displayed in the recipient's viewing area. This feature is useful when you have tabular
material in your message that might be difficult to read if the lines wrap.

When you check this box, your lines of text may extend off the right side of the recipient's viewing area; if
s0, a horizontal scroll bar at the bottom of the viewing area will let the recipient scroll to see the rest of
your text.

With this box unchecked, the lines of text will automatically reformat ("wrap") to fit the recipient's viewing
area, and no horizontal scroll bar will display.



Notify of receipt

Check the Notify box if you want CompuServe to let you know the message has been received.



Options

Click here to see the Mail Options dialog box.

See Options for more.



Text entry area

This is the area where you type the text of your message.



Folders

This is the list of folders.

See Folders for more.



Mail (menu option)

The Mail option on the Viewer menu bar has options that let you create, delete, view, reply to, and
otherwise manage your CompuServe e-mail messages.

Click on the menu choices below to learn more about each one.
Mail
Create
Delete
Delete All in Folder

Send Now
Send Later

Editf¥iew
Attachments

Reply

Forward

Move

Sort 3

Find
Find Next

Edit Address Book




Send Now/Send later

Once you've written a message (it will typically be in the Out Box or the Mail Drafts folder), use the Send
Now or Send Later options on the Mail menu bar to tell Rosebud when to send it.

Send Now - Rosebud will log on to CompuServe immediately and send the message.

Send Later - Rosebud will send the message at the next regularly scheduled logon.



Edit/View Mail

How to view a message

1. Highlight the message in the list in the top part of the viewing area.

2. Click Mail on the menu bar.

3. Click Edit/View. The Create Mail or Edit/View Mail dialog box appears, with the full message and all
recipients displayed.

NOTE: The Create Mail dialog box also comes up when you double-click the message on the
list.



Forward mail

How to forward a message

1.
2.

Highlight a message in the list at the top of the viewing area.

On the menu bar, click Mail, then Forward (or click the Forward tool on the toolbar). The Create
Mail dialog box appears, displaying the original message prefaced by lines indicating where the
message originated.

Add to the message if you like.

Click on the To button to bring up your Address Book, where you can enter a new name directly, or
select from existing names.

Click the Send Now radio button to have Rosebud send the message immediately.

Click the Send Later radio button if the message can wait for Rosebud's next scheduled run.
Click the Store in radio button if you want to forward the message to a folder.

Click OK.



Move

How to move a message

1.

ok oN

Highlight the message in the list at the top of the viewing area.

Click Mail on the menu bar.

Click Move. You'll be shown a list of folders to which the message can be moved.
Click the folder you want.

Click OK.



Print Message

How to print a message
1. Highlight the message in the list in the Viewer.
2. Click Mail on the menu bar.

3. Click Print Message.

You can also print a highlighted message by selecting File Print, or by clicking the Print button on the left
side of the mail dialog box.



Sort

How to sort messages using the menu
1. Click on Sort to see a fly-out menu of sort choices.
2. Click on your choice:

» Sort alphabetically by subject.

» Sort by date, oldest first.

» Sort by date, newest first.

» Sort alphabetically by sender.

How to sort mail messages using the toolbar

Click on the appropriate sort tool.



Store in

Click the Store in radio button to store the message in any of your mail folders.



Launch (menu option)

The Launch menu lets you launch the Collection Agent and the Assignment Desk directly from the Viewer.

Assignment Desk
Collection Agent
You can do the same thing from the toolbar.




Colors tab

Click here to bring the Colors tab to the front, then use the Change button to change the colors on the
news articles or mail messages that the Viewer displays.

See News and mail colors to learn more about changing colors.



Fonts tab

Click here to bring the Fonts tab to the front, then use the Change button to change the fonts on the
graphs or text that the Viewer displays.

See News and mail fonts to learn more about changing fonts.



Chart areas

This is a list of the parts of the viewing area whose color you can change. Click on the name of the part
of the viewing area you want to change, then click the Change button to bring up the Color dialog box.
Click on a new color and click OK; note that the preview area changes to reflect your new color choice.

See News and mail colors and News and mail fonts to learn more.



Change button

Once you highlight the name of the part of the viewing area (Text Color, Background Color, etc.) you want
to change, click the Change button to bring up the Color or Font dialog box.

See News and mail colors and News and mail fonts to learn more.



News and mail colors

The Mail Display Setup dialog box and the bottom half of the News Display Selection dialog box contain
two tabs: Colors and Fonts. Note the labeled extensions of each tab at the bottom of the dialog box.
Click on the extension labeled Colors to bring the Colors tab to the top.

The Colors tab lets you change the colors of the display. In the list box on the right, double-click on the
name of the viewing area you want to change (Background Color, Text Color, etc.) to bring up a Color
dialog box. (You can also bring up the Color dialog box by clicking on the viewing area name and then
clicking on Change.)

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

In the Color dialog box, click on the color you want and click OK.

For information on the other part of the Mail Display Setup and News Display Selection dialog boxes:
News and mail fonts



News and mail fonts

The Mail Display Setup dialog box and the bottom half of the News Display Selection dialog box are
made up of two tabs: Colors and Fonts. Note the labeled extensions of each tab at the bottom of the
dialog box. Click on the extension labeled Fonts to bring the Fonts tab to the top.

The Fonts tab lets you change the fonts (typefaces) used in the display of your news articles and mail
messages. In the list box on the right, double-click on the name of the viewing area you want to change
(Title Font, Text Font, etc.) to bring up a Font dialog box. (You can also get to the Font dialog box by
clicking on the viewing area name and then clicking on Change.)

NOTE: The preview area in the lower left of the dialog box shows you what the display looks
like.

In the Font dialog box, select a new font, font style, and font size from those shown as available on your
system. Click OK. Note that the preview area changes to reflect your new font choices.

For more on the other part of the Mail Display Setup dialog box and the News Display Selection dialog
box:

News and mail colors



Message alert

When Rosebud finds e-mail for you on CompuServe, it retrieves it, puts it in the In Box in the Mail section
of the Viewer, and puts a message up on your screen to let you know you have mail waiting. To read the
mail, load the Viewer (if it's not already loaded) by double-clicking on its icon; then select Mail and In Box
if they're not already selected. A list of messages displays in the top part of the viewing area; highlight
the message you want to see, and its text appears in the lower part of the viewing area. You can read it,
reply to it, forward it, print it, or delete it. See the Mail menu or the options below for more.

How to reply to mail
How to forward mail

How to print mail
How to delete mail

The message alert screen offers you some menu options for customizing the message alert screen itself.
You can change the colors of the message displays, for example.

NOTE: The first time Rosebud attempts to retrieve Executive News Service (ENS) information
from CompuServe for you, the Message alert screen displays something called the ENS
agreement text; click Proceed to indicate your acceptance of the terms of the ENS agreement,
or Cancel to reject the agreement. You must accept in order for Rosebud to retrieve ENS
articles. Once you accept it, the message is not displayed again. Keep in mind that ENS
information costs extra.



Folder Title

The text you type here is the wording that appears as the label of the Folder.



Mail tools

The

toolbar that displays when you're in the mail topic has tools that don't appear on the toolbar in the

other three topics.
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Click the Create tool to begin a mail message from scratch. You'll be taken to the Create Mail dialog
box.

Click the Reply tool to reply to an existing message. You'll be taken to the Reply to Mail Message
dialog box.

Click the Forward tool to send a message to another folder or to another recipient. You'll be taken to
the Forward dialog box

Click the Send tool to send the highlighted message.

Click the Wastebasket tool to move the highlighted message to the Wastebasket folder for later
removal.

Click the Sub tool to sort your mail alphabetically by the subject line.
Click the "counterclockwise" clock to sort your mail by date (newest first).
Click the "clockwise" clock to sort your mail by date (oldest first).

Click Frm to sort your mail alphabetically by the sender's name.



Launch tools

The second group of two tools on the toolbar lets you launch the Collection Agent and the Assignment
Desk directly from the Viewer.

You can do the same thing from the menu.




Attachments - incoming

How to get to the attachment on an incoming messge

When an incoming message has an attachment, you’ll be alerted to that fact by a special message line in
the top portion of the viewing area, and the presence of a diskette icon attached to the envelope icon at
the left end of that message line.

1. Double-click on the message line in the list. The Create Mail dialog box appears, with the
attachment’s file name displayed.

Click the Attachment button. The Attachment dialog box appears.
Highlight the attachment’s file name in the list box.

Click Save to save the file wherever you want it.

NOTE: You can go directly to the Attachment dialog box by highlighting the message line in the
Viewer, selecting Mail from the menu, and selecting Attachments.

Attachments - outgoing



Copy tool

The Copy tool on the Viewer toolbar places a copy of the displayed page on the Clipboard.

The Copy command on the Item menu, or the keyboard shortcut Ctrl-C, also let you copy.



News tools

The toolbar that displays when you're in the news topic has some tools that don't appear when you're in
the other three topics.

Later | Mo | | Elear|

» Click Later if you've selected a headline of an unretrieved article and want to retrieve the actual
article on the next scheduled retrieval.

+ Click Now! if you've selected a headline of an unretrieved article and want to retrieve the actual
article immediately. You can also select an item that's marked to be retrieved later, and change it to
now.

*  Click Clear to clear any previous request to retrieve an article..



Toolbar

This is the Viewer toolbar.

See Toolbar for more.



Item: Copy

The ltem Copy command copies the selected item to the Clipboard.
The keyboard shortcut is Ctrl-C.




Item: Zoom

The ltem Zoom command removes the column of folders from the left side of the screen and enlarges the
viewing area to fill the screen. Select ltem Zoom a second time to restore the screen.

The keyboard shortcut is Ctrl-Z.




Item: Find/Find Next
Mail: Find/Find Next

Use the Find and Find Next commands on the ltem menu to look for specific text in text items.

Use the Find and Find Next commands on the Mail menu to look for specific text in mail messages.



Delete All in Folder

Use the Delete All in Folder command on the Mail menu to delete all messages in the current folder.



Print

If this button is active, you can click it to print the displayed message.



Attachments - outgoing

How to attach a file to an outgoing message

1. Create the message, or reply to an existing message, in the usual manner (see How to create a
message and How to reply to a message).
2. Still at the Create Mail (or Reply to Mail Message) dialog box, click on the Attachments button.

The Attachment dialog box appears.

Cancel

- Atachments |
| (118 I
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Comment: |

Type: | Text

3. Click File to see the Add Attachment dialog box, a standard file selection window that lets you
search your drives and directories for the file you wish to send with the message.

4. When you find the file, double-click it; its path and file name appear in the File text box.
5. Add a comment if you like.

6. Under Type, click on the down arrow button to see the list of possible files types. Click on the
appropriate one.

Rule of thumb: If you can read it in Windows Notepad, it's a text file.
Click Add/Update.
Click OK to return to the Create Mail (or Reply to Mail Message) dialog box.
Select Send Now, Send Later, or Store in, as appropriate.

Click OK.
Attachments - incoming
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Options

The Options button on the Create Mail dialog box brings up the Mail Options dialog box. Move your
mouse over the graphic below; when the pointer changes to a pointing hand, click to learn more.

Mail Options

Payment Method
_} Split charges ITI

Sensitivity: | Mormal |£I

Importance: | Hormal |£I

Expiration D ate: |:|

Release Date:




Payment Method

These radio buttons let you indicate how any message charges will be billed. If you select Receiver
pays, keep in mind that some users have their mail retrieval set up to ignore postage-due messages, and

your message won't be delivered.



Sensitivity

Click the arrow button to see a list of Sensitivity options to choose from.



Importance

Click the arrow button to see a list of Importance options to choose from.



Expiration date

Enter the date after which there's no point in delivering the message. The date of the company picnic
has already passed.



Release date

Enter the date when you want the message delivered.



Incoming message text

The text of the message you're replying to is displayed in this area of the Reply to Mail Message dialog
box. Scroll bars let you move through the message text.



Art

Each of the four topics (News, Weather, Mail, and Financial) has its own graphic here.



Item: Collect Later/Collect Now

If the item is a headline of an unretrieved news article, use the Item Collect Later/Collect Now commands
to tell Rosebud when to retrieve the articles themselves.



Item: Agreement

If the item is a news article, the right mouse button Item menu includes an Agreement option required for
copyright notification purposes.



Item: Clear request

If the item is a news article, the right mouse button ltem menu includes a Clear Request command. Use
it if you've marked a headline of an unretrieved article so that Rosebud will retrieve the actual article, and
now want to clear the retrieve request.



From

The From area is already filled in with your name.



To

Since you're replying to an incoming message, the To area is already filled in with the recipient's name
taken from the incoming message.

See To, CC, and BCC recipients for more.



Subject

Since you're replying to an incoming message, the subject line is already filled in with the subject line
from the incoming message. You can change it if you like.



Technical support

If you need help with Rosebud:

*  Voice (9:00 a.m. - 5:00 p.m. Eastern Time): 770-662-5387
* Big Peach BBS (24 hours): 770-446-6650

* CompuServe: 76004,1541 or GO ROSEBUD

* MHS: Support@Magee

* Internet: support @magee.com

Tech tip



To, CC, and BCC recipients

When you click on the To, CC, or BCC buttons at the Create Mail or Reply to Mail Message dialog boxes,
the dialog box below displays. It's the Address Book, but its title will vary depending upon whether you
entering a To (a primary recipient) or a CC/BCC.

See the Address Book and Edit Address Book for how to enter, select, and edit names and addresses.

Primary Recipients
Mew Addrezs 0K I

| |Add Hecipient | Cancel I

Hamesz & Addresses Lelected Recipients
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Colors

The Color dialog box appears when you click Change with the Color tab selected. This dialog box lets
you select the color you want for a particular part of the display (title, background, etc.); it's the same for
all four topics (Mail, News, Financial, and Weather.

To select a basic color

1.
2.

In the Basic Colors palette, click on the color you want.

Click OK to return to the setup screen.

To create a custom color

1.
2.

5.

In either the Basic or Custom Colors palette, click on a color that's close to what you want.

Click Define Custom Color. The dialog box expands to let you experiment with the colors. The
basic color you chose displays in the box at the bottom, and an indicator on the color screen shows
where that color falls.

Change the selected color, either by dragging the indicator to the desired location on the color screen,
or by typing values in the text boxes. You can drag the vertical indicator at the far right to change the
character of the color. The preview area changes to reflect your selections.

Click Add to Custom Colors when you're satisfied. The new color appears in the Custom Colors
palette below the Basic Colors palette.

Click OK to return to the setup screen. The preview are there reflects your new color selection.

To delete a custom color

1.
2.
3.

Click on the custom color in the Custom Colors palette.
Click on the white square (at the bottom right of the Basic Color palette).
Click Add to Custom Colors.



Font

The Font dialog box appears when you click Change with the Font tab selected. This dialog box lets you
select the font you want for a particular part of the display (title, background, etc.); it's the same for all four
topics (Mail, News, Financial, and Weather.

Using the three list boxes, select the font, font style, and font size you want. The preview area in the
lower right shows you what your selection will look like. Click OK to return to the setup screen.

= Font
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How to add or edit an Address Book entry

How to add an entry

1.

Click the Add button at the Edit Address Book dialog box to bring up the Address Book Entry dialog
box below.

Enter the new name and address
Enter an optional comment.
Click OK.

TIP: You can also copy an address directly from an incoming message into your Address
Book. At the main Viewer screen, double-click the message line in the upper portion of the
Viewer. At the View Mail or Create Mail dialog box, click on the From: button. When the
From Address dialog box appears, click the Copy button.

How to edit an entry

1.

2
3.
4

Highlight an existing entry at the Edit Address Book dialog box.
Click the Edit button to bring up the Address Book Entry dialog box.
Make changes to the name, address, or comment.

Click OK.

Address Book Entry

Hame: |

Cancel

Address: |

Comment




Print tool

Click on the Print tool on the Viewer toolbar to print the material displayed in the viewing area.

The Print command on the File menu (or the keyboard shortcut Ctrl-P) also let you print.



From

This area automatically displays your name and address as the sender of this message.



Retrieved information: where is it?

Once the Collection Agent retrieves news, weather, or financial information, it stores it on your hard drive.
Most of it goes into special databases in the Rosebud directory, but certain weather information goes in
your TEMP directory.

The information stays on your hard drive until Rosebud automatically deletes it. If you watch the
Collection Agent, you can see it doing this automatic clean-up each morning.

How long the retrieved information stays before it's deleted depends on certain settings in the Assignment
Desk. To see (or change) these settings, go to the Assignment Desk and highlight Financial, Weather, or
News. Click the Change button to get to the Settings dialog box for that topic.



Zoom

Click on the Zoom tool on the Viewer toolbar to make the viewing area fill the whole screen. The column
of folders on the left disappears.

Click the Zoom tool a second time to restore the screen.

The Zoom command on the ltem menu, or the keyboard shortcut Ctrl-Z, also let you zoom.









